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Preface
Welcome to the Hyperion Analyzer Installation Guide for UNIX. This preface 
includes the following topics:

● “Purpose” on page vii

● “Audience” on page vii

● “Document Structure” on page viii

● “Product Documentation” on page ix

● “Where to Find Documentation” on page x

● “Conventions” on page xi

● “Additional Support” on page xii

Purpose
The Hyperion Analyzer Installation Guide explains product conventions, features, 
and options, and it contains the concepts, processes, procedures, formats, tasks, 
and examples that you need to install Hyperion Analyzer.

Audience
Although this guide is intended for system and application administrators 
responsible for installing, configuring, and maintaining Hyperion Analyzer, 
advanced users can also benefit from the procedures and conceptual information. 
■ viiHyperion Analyzer Installation Guide for UNIX



Preface
Document Structure
This document contains the following information: 

● Chapter 1, “Hyperion Analyzer Overview,” introduces the Hyperion Analyzer 
product and the components of the application. The chapter also provides an 
overview of the architecture and the installation options. 

● Chapter 2, “Installing Hyperion Analyzer on UNIX,” provides information on 
the system requirements for the server and Java web client. In addition, it 
provides a preinstallation checklist and installation procedures to install 
Hyperion Analyzer in a UNIX operating environment.

● Chapter 3, “What’s Installed?,” provides information on what is installed and 
where it is located in the Hyperion Home and default installation directories. 

● Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” provides 
detailed information on installing Hyperion Analyzer on an existing IBM 
WebSphere application server.

● Chapter 5, “Deploying Hyperion Analyzer into BEA WebLogic,” provides 
detailed information on installing Hyperion Analyzer on an existing BEA 
WebLogic application server.

● Chapter 6, “Creating Repositories with Scripts,” contains the procedures to 
manually create the database repositories and the required tables with scripts.

● Chapter 7, “Importing Hyperion Analyzer Sample Reports,” describes the 
procedures to import Hyperion Analyzer and API Toolkit sample reports 
through the Java Web Client.

● Chapter 8, “Uninstalling Hyperion Analyzer,” describes how to uninstall 
Hyperion Analyzer from your UNIX operating system.

In addition, an index provides easy access to information contained in the book.
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Product Documentation

Information Map
The Hyperion Analyzer Information Map lists and describes all Hyperion 
Analyzer documentation and its location. 

➤ To display the information map:

1. Perform one of the following:

● From the Hyperion Analyzer Launch Page, click the Information Map 
link.

● From a browser window, enter the following URL:
http://<server>/Analyzer7_Server/Help/en/InformationMap/
information_map.htm

Getting Started
Hyperion Analyzer Getting Started gives an overview of Hyperion Analyzer, 
relates terminology central to multidimensional analysis, explains application 
fundamentals and graphical user interfaces, and leads you through the creation of 
your first report using the Hyperion Analyzer Java Web Client.

New Features
Hyperion Analyzer New Features describes all new features specific to this 
release.

Client Online Help

Java Web Client Online Help
The Hyperion Analyzer Java Web Client Online Help provides detailed 
information about navigation, report creation, and advanced Java Web Client 
topics.
■ ixHyperion Analyzer Installation Guide for UNIX



Preface
HTML Web Client Online Help
The Hyperion Analyzer HTML Web Client Online Help provides detailed 
information about navigation, report creation, and the features specific to the 
HTML Web Client.

Where to Find Documentation
All Hyperion Analyzer documentation is accessible from the following locations:

● The HTML Information Map is located at:

http://<server>/Analyzer7_Server/Help/en/InformationMap/
information_map.htm

● Online help is accessible from the user interface that it documents. Start the 
product and click the Help button or menu command.

● The Hyperion Solutions Web site is located at 
http://www.hyperion.com.

➤ To access the documentation from the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select the Support link and type your username and password to log on.

Note: New users must register to receive a username and password.

3. Follow the on-screen instructions.

➤ To access the documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com .

2. In the Login ID and Password text boxes, type your assigned login ID and 
password. Then click Login.

3. If you are a member on multiple Download Center accounts, select the 
account that you want to use for the current session.

4. From the Product List, select Hyperion Analyzer.

5. In the New Releases tab, select Hyperion Analyzer 7.0.
x ■ Hyperion Analyzer Installation Guide for UNIX
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Conventions
The following table shows the conventions used in this document:

Table i: Conventions Used in This Document 

Item Meaning

Arrows indicate the beginning of a procedure consisting 
of sequential steps or a one-step procedure.

Brackets [] In examples, brackets indicate that the enclosed elements 
are optional.

Bold Bold in procedural steps highlights major interface 
elements.

CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the + sign.

Example text Courier font indicates that the material shown is a code or 
syntax example.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

n, x Italic n stands for a variable number; italic x can stand for 
a variable number or an alphabet. These variables are 
sometimes found in formulas.

Ellipses (...) Ellipsis points indicate that text has been omitted from an 
example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.
■ xiHyperion Analyzer Installation Guide for UNIX



Preface
Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following product information and support. For details on education, consulting, 
or support options, visit Hyperion’s Web site at http://www.hyperion.com.

Education Services
Hyperion offers instructor-led training, custom training, and eTraining covering 
all Hyperion applications and technologies. Training is geared to administrators, 
end users, and information systems (IS) professionals. 

Consulting Services
Experienced Hyperion consultants and partners implement software solutions 
tailored to clients’ particular reporting, analysis, modeling, and planning 
requirements. Hyperion also offers specialized consulting packages, technical 
assessments, and integration solutions.

Technical Support
Hyperion provides enhanced electronic-based and telephone support to clients to 
resolve product issues quickly and accurately. This support is available for all 
Hyperion products at no additional cost to clients with current maintenance 
agreements.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning
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Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by clicking the link for the Documentation Survey, which is located on 
the Information Map for your product.
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Chapter
1

Hyperion Analyzer Insta
Hyperion Analyzer Overview
Hyperion Analyzer consists of the following components:

● Repository – A central storage location for Hyperion Analyzer system data, 
user IDs, user preferences, and report definitions in relational database tables.

● Hyperion Analyzer Analysis Server – A servlet-based Web application that 
resides within the J2EE application server. The Analysis Server facilitates the 
rendering of reports to either the HTML or Java clients and provides 
Web-based user management.

● Hyperion Analyzer Administration Tools – A client that provides a Java 
graphical interface for managing users, users groups, and database 
connections using a supported Web browser. It also provides access to several 
administration utilities.

● Hyperion Analyzer Java Web Client – A client that enables online analysis 
of data. You can design and format custom analysis applications without 
“coding.” Hyperion Analyzer is commonly used to conduct sales, key 
performance, and financial and forecasting analyses.

● Hyperion Analyzer Windows Client – A Java Web client interface and 
functionality delivered as a Java application for supported Microsoft 
Windows operating systems.

● Hyperion Analyzer HTML Web Client – An HTML thin client used by way 
of a supported Web browser. It is engineered for information consumers who 
do not require advanced design and content-creation capabilities.

● Hyperion Analyzer API Toolkit – A tool that developers can use to 
incorporate the Hyperion Analyzer Java Web Client look and feel and 
functionality into their own custom Web applications.
■ 15llation Guide for UNIX



Architectural Overview
Hyperion Analyzer functionality is distributed across a multi-tiered architecture:

● Client layer

● Mid-tier layer

● Database server layer

Figure 1: Hyperion Analyzer Architecture

The client layer comprises the three Web browser clients and the API Toolkit. All 
clients communicate with the rest of the Hyperion Analyzer system using 
Hypertext Transfer Protocol (HTTP).

The mid-tier layer includes the following components:

● The Web server

● The J2EE application server

● The Hyperion Analyzer Analysis Server

● Drivers and protocols for communicating with the database server layer
16 ■ Hyperion Analyzer Installation Guide for UNIX



Architectural Overview

1

The database server layer supports and shares both OLAP and relational databases, 
and the relational Hyperion Analyzer repository. Data source connectivity to 
Hyperion Financial Management and Hyperion Planning is also available.

A supported Web server is required to present the Web page from which Web 
clients are launched, to deliver files containing Java components, and to transport 
images generated at run time. After clients are established, the Web server 
manages all client mid-tier HTTP communication.

Hyperion Analyzer runs inside a J2EE application server. The supported J2EE 
application server shares Hyperion Analyzer business logic, network traffic, 
application security for large numbers of concurrent users, and provides load 
balancing and fault tolerance.

Through the installation process, Hyperion Analyzer is deployed into a J2EE 
application server, and Hyperion Analyzer tables are created on the RDBMS 
selected repository option. The system leverages a Web server to communicate 
with clients.
■ 17Hyperion Analyzer Installation Guide for UNIX



Deployment Options
Hyperion Analyzer provides a great deal of flexibility in the way you can 
configure the system. Configuration options are determined by several factors. 
Among other considerations, the following list includes some possible 
considerations for making deployment decisions:

● Current hardware and software

● Future hardware and software upgrades

● Quantity of data

● The balance between ease of configuration and performance

In an effort to assist you in your decision-making, Hyperion recommends 
examining the following deployment options:

“Deployment Option 1” on page 19

“Deployment Option 2” on page 20

“Deployment Option 3” on page 21

“Deployment Option 4” on page 22
18 ■ Hyperion Analyzer Installation Guide for UNIX



Deployment Options

1

Deployment Option 1

The first deployment option supports medium to large configurations. In this 
instance, the Web server and application server are on the same computer and are 
separate from the RDBMS repository and data sources. This is the most typical and 
highly recommended configuration option. The separation of the components 
allows for high scalability, and you can upgrade each hardware component 
individually, as needed.

Figure 2: Hyperion Analyzer Deployment Option 1
■ 19Hyperion Analyzer Installation Guide for UNIX



Deployment Option 2
Deployment Option 2 establishes the Web server, application server, and RDBMS 
repository on same computer and separate from the data sources. This 
configuration option is used for medium-size deployments.

Figure 3: Hyperion Analyzer Deployment Option 2
20 ■ Hyperion Analyzer Installation Guide for UNIX



Deployment Options

1

Deployment Option 3

The third deployment option is intended to support a large enterprise system with 
an existing systemic structure that Hyperion Analyzer can integrate into and 
leverage. The Web server and application server are on separate computers, as are 
the RDBMS repository and data sources. This is the typical configuration option 
for an enterprise with a centralized Web server. However, this configuration 
requires more in depth knowledge of Web server and application server 
configuration.

Figure 4: Hyperion Analyzer Deployment Option 3
■ 21Hyperion Analyzer Installation Guide for UNIX



Deployment Option 4
The forth deployment option is best utilized for a small deployment, testing and 
prototype situations. The Web server, application server, Essbase/Hyperion 
Financial Management and RDBMS Repository are all on the same server. This 
option is not recommended for high concurrent usage, unless the servers have 
multiple CPUs and maximized availability of RAM.

Figure 5: Hyperion Analyzer Deployment Option 4
22 ■ Hyperion Analyzer Installation Guide for UNIX



Installation Options

1

Installation Options 
You can install Hyperion Analyzer using any of the following procedures:

● Microsoft Windows Installation – Use the 
HyperionAnalyzerSuite7_0_0.exe installation file to install Hyperion 
Analyzer on Microsoft Windows operating systems. You have the option of 
installing to the Apache Tomcat application server installed during the 
Hyperion Analyzer installation, an existing Apache Tomcat, IBM WebSphere, 
or BEA WebLogic application server. See Hyperion Analyzer Installation 
Guide for Windows for more information.

● UNIX operating system – Use the HyperionAnalyzerAix.bin, 
HyperionAnalyzerHP11.bin, and HyperionAnalyzerSolaris.bin 
executables to install the Hyperion Analyzer Analysis Server on either the 
IBM AIX, HP-UX, or Sun Solaris UNIX operating systems. Depending on the 
operating system you are using, you have the option of installing to the 
Apache Tomcat application server, an existing Apache Tomcat, IBM 
WebSphere, or BEA WebLogic application server. See the Chapter 2, 
“Installing Hyperion Analyzer on UNIX,” for more information.

● Manual deployments to application servers – You can deploy Hyperion 
Analyzer manually to several application servers if you prefer not to use the 
provided application server. The following options are available:

– IBM WebSphere installation – You must manually deploy Hyperion 
Analyzer onto a previously installed application server. See Chapter 4, 
“Deploying Hyperion Analyzer into IBM WebSphere,” for more 
information.

– BEA WebLogic installation – You must manually deploy Hyperion 
Analyzer onto a previously installed application server. See Chapter 5, 
“Deploying Hyperion Analyzer into BEA WebLogic,” for more 
information.
■ 23Hyperion Analyzer Installation Guide for UNIX
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Chapter
2
2
Hyperion Analyzer Insta
Installing Hyperion Analyzer 
on UNIX
This chapter outlines the system requirements, prerequisites, and procedures to 
install Hyperion Analyzer on a supported UNIX operating system. It contains the 
following sections:

● “System Requirements” on page 26

● “Before Installing Hyperion Analyzer” on page 30

● “Installation Summary” on page 32

● “Installing Hyperion Analyzer” on page 33

● “After Installing Hyperion Analyzer” on page 48

● “Starting the Hyperion Essbase OLAP Server” on page 52
■ 25llation Guide for UNIX



System Requirements
Before you install Hyperion Analyzer on UNIX, it is important to understand the 
system requirements.

Platform Support Matrix
Hyperion Analyzer is supported on the platform software specified in the 
following tables. Subsequent maintenance releases and service packs may be used 
where the vendor asserts backward compatibility. Please be aware, however, that 
while these assertions are made in good faith, certain incompatibilities may exist. 
In the event that an incompatibility is identified, Hyperion may experience a delay 
in reproducing and fixing resultant issues for the affected versions.
26 ■ Hyperion Analyzer Installation Guide for UNIX



System Requirements

2

Server System Requirements
Table 1: Hyperion Analyzer Server System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 512 MB RAM

Disk Space 1 GB of processing space

Operating System One of the following Operating Systems:

• Sun Solaris 5.8

• IBM AIX 4.3.3, 5.1 or 5.2

• HP_UX 11i

Web browser One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2 or 7.0

Java plug in 1.3.0_02 or 1.3.1_09

Spreadsheet 
add-ins

Microsoft Excel 97 (sp1 or 2), 2000 or XP

Peripherals • SVGA monitor, 800x600 resolution

• CD-ROM drive

Network 
connection

TCP/IP

Application 
servers

One of the following servers:

• Tomcat 4.0.4

• Tomcat 4.1.18 (full installation provided)

• IBM WebSphere 4.0.5 Advanced Edition, or Advanced 
Edition Single Server

• IBM WebSphere 5.0, Express, or Enterprise Edition

• BEA WebLogic 6.1.4 (Service Pack 3 is supported)

• BEA WebLogic 7.0

• BEA WebLogic 8.1
■ 27Hyperion Analyzer Installation Guide for UNIX



Note: To assist you in getting started quickly, Hyperion provides the Apache Tomcat 
Application Server with Hyperion Analyzer. Because the Apache Tomcat Application 
Server software is not intended to support large user communities in production 
environments, it is recommended that it is deployed with Hyperion Analyzer in test or 
demonstration environments where a controlled number of individuals will access and 
use the software. 

OLAP servers One of the following servers:

• Hyperion Essbase 6.2.4, 6.5.4 or 7.0

• IBM DB2 OLAP Server 7.1 (FixPak 11)

• IBM DB2 OLAP Server 8.1 (FixPak 2)

Relational data 
sources

Hyperion Financial Management 3.4 or 3.5

Hyperion Planning 3.5 (Essbase component)

Relational servers One of the following servers:

• IBM DB2 8.1 Enterprise Server Edition

• Microsoft SQL Server 2000, SP3, MS SQL Server JDBC 
drivers (Not supported as a repository.)

• Oracle 8.1.7 or 9.2.1, Native JDBC drivers

• Teradata 4.1

Other • Applicable Hyperion Essbase Runtime client

• Adobe Acrobat Reader 5.0

Table 1: Hyperion Analyzer Server System Requirements(Continued)

Component Requirement
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2

Java Web Client System Requirements
Table 2: Hyperion Analyzer Client System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 256 MB RAM

Disk space 25 MB

Operating system One of the following operating systems:

• Microsoft Windows NT 4.0, Service Pack 6a

• Microsoft Windows 2000, Service Pack 3

• Microsoft Windows XP

• Microsoft Windows 2003

Web browser for 
Web client

One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2 or 7.0

Web browser for 
Java client

One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2, or 7.0

Java plug in for 
Java client

Sun Java Plug-in 1.3.0_02 or 1.3.1_09 

Note: Installed automatically on first use of Hyperion 
Analyzer.

Other Adobe Acrobat Reader 5.0
■ 29Hyperion Analyzer Installation Guide for UNIX



Before Installing Hyperion Analyzer
Before you install Hyperion Analyzer, there are a number of prerequisite tasks and 
considerations to execute and/or examine for applicability to your situation. The 
following sections describe this information:

● “Preinstallation Checklist” on page 30

● “RDBMS Considerations” on page 31

● “Backing Up an Existing Repository” on page 32

Preinstallation Checklist
Complete the following tasks that apply to your installation situation prior to 
installing Hyperion Analyzer:

● When you install Hyperion Analyzer on a UNIX operating system, you must 
install the software using the XWindows user interface. 

● We recommend that you not use spaces in path names and location 
descriptions.

● Review the system requirements for your configuration and ensure 
compliance.

● If there is a previous release of Hyperion Analyzer on the system, create a 
backup of the Hyperion Analyzer repository. For more information see, 
“Backing Up an Existing Repository” on page 32.

● Verify the server and path names. Do not use the name “localhost” to identify 
servers.
30 ■ Hyperion Analyzer Installation Guide for UNIX
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■ 31Hyperion Analyzer Installation Guide for UNIX

● Ensure the availability of user names and passwords for your Hyperion 
Essbase OLAP server and your RDBMS. 

Note: The name “System” cannot be used for logon accounts. Duplicate logons 
and passwords cannot be used. Ensure that your unique logons do not exceed 
eight (8) characters in length.

● Ensure that the correct JDBC drivers are available for the RDBMS repository 
you are using.

● If you plan to use a preinstalled Apache Tomcat application server, ensure that 
it is stopped.

● If you plan to use a preinstalled RDBMS system, ensure that the service is 
started.

RDBMS Considerations

IBM DB2 Version 7.2
When using IBM DB2 7.2 as the relational repository for Hyperion Analyzer, you 
must configure DB2 to use JDBC 2.0 drivers and ensure that the following 
repository types comply as required:

● Enterprise Server Edition

IBM DB2 7.2 users must perform additional steps after completing the installation. 
For more information, see “Configuring IBM DB2 JDBC 2.0 Drivers” on page 48.

Enterprise Server

● Enter the case-sensitive database server name when specifying locations and 
paths. “Localhost” is not a recommended server name.

● User names are restricted to eight (8) characters or less.

IBM DB2 Enterprise Server Edition Only

● Ensure that user names are granted connection privileges to the database.

● Ensure the database and user name are created prior to installation to create 
the RDBMS repository.



Oracle
● A Root logon is required to create a tablespace in Oracle.

● Use the case-sensitive tablespace server name when specifying locations and 
paths. “Localhost” is not a recommended server name.

● Do not create the tablespace or the user name prior to installation. The installer 
creates the both inside the database.

Backing Up an Existing Repository
The database tables in the Hyperion Analyzer 7.0 repository have been 
reorganized. During the installation, the tables are migrated to the new structure. 
Before beginning the installation, you must back up your existing repository. As a 
result of the table changes, previous releases of Hyperion Analyzer repository do 
not work with Hyperion Analyzer 7.0.

Installation Summary
To install Hyperion Analyzer successfully, you must complete the following tasks:

● Select the Hyperion Home directory.

● Select a usage mode and setup type.

● Review the terms of the license agreement.

● Select a location to install Hyperion Analyzer.

● Select and configure the application server.

● Select and configure the RDBMS.

● Configure Hyperion Analyzer.

● Review the summary of the installation.

● Complete the installation.

● Configure the software for your system.
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Installing Hyperion Analyzer

2

Installing Hyperion Analyzer
The following procedures guide you through the process of installing Hyperion 
Analyzer.

Note: During the installation of Hyperion Analyzer, progress through the windows by 
clicking the Next button. To cancel the installation, click the Cancel button.

➤ To install Hyperion Analyzer:

1. Perform one of the following tasks:

● If you have the Hyperion Analyzer CD, insert the CD in your CD-ROM 
drive.

● If you downloaded the Hyperion Analyzer software from an FTP site or 
the Hyperion Download Center, perform one of the following tasks:

– Navigate to the directory where you downloaded the installation 
application and double-click <bin file>.

– On the XWindows desktop, from a terminal window, type the 
<path>/<bin file> and click OK.

Where <path> is the location of the Hyperion Analyzer installation 
application. Where <bin file> is one of the following scripts: 

./HyperionAnalyzerAix.bin

./HyperionAnalyzerHP11.bin

./HyperionAnalyzerSolaris.bin
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The Welcome window is displayed.

Figure 6: Installation Welcome 

2. Click Next.
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Installing Hyperion Analyzer

2

The Select Hyperion Home window is displayed.

Figure 7: Select Hyperion Home 

The first time you run the Hyperion Analyzer installer on a machine, you are 
prompted to select the Hyperion Home directory. The default path is 
//Hyperion. You can type or click Browse to change the Hyperion Home 
directory. Once defined, all required common components for Hyperion 
applications are stored in the Hyperion Home directory. For additional 
information on the files and folders stored in the Hyperion Home directory, see 
Chapter 3, “What’s Installed?”.

3. Type or click Browse to choose the location of your Hyperion Home directory. 
If you have not created a Hyperion Home directory, one is created for you 
based on the path name you enter. If a Hyperion Home directory is detected, 
you cannot select a new directory. Later in the installation process you have 
the option to install Analyzer in the Home directory or a different location. 

4. Click Next.
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The License Mode window is displayed.

Figure 8:  License Mode 

5. Select one of the following usage types:

● To install a trial version of Hyperion Analyzer, select Evaluation.

● To install a licensed version of Hyperion Analyzer, select Licensed and 
then enter a valid license key.

Note: Your can locate your license key on the Hyperion Download Center at 
http://hyperion.subscribenet.com.

6. Click Next.
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The License Agreement window is displayed.

Figure 9: Installation License Agreement 

7. After reviewing the license agreement, select I accept the terms of the 
license agreement, then click Next.
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The Select Location window is displayed.

Figure 10: Select Location

8. Type the location where you want to install Hyperion Analyzer or click 
Browse to choose a location, then click Next.
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The Select Application Server Type window is displayed.

Figure 11:  Select Application Server Type 

9. Select one of the following application server options:

● Tomcat 4.0 – Installs Hyperion Analyzer on an Apache Tomcat 4.0 
application server.

● Tomcat 4.1 – Installs Hyperion Analyzer on an Apache Tomcat 4.1 
application server.

– Optional: Select to Install Tomcat 4.1.18. If you do not yet have an 
application server installed, Apache Tomcat 4.1.18 and Hyperion 
Analyzer are installed as part of the “batteries included” option.

● IBM WebSphere 4 – Installs Hyperion Analyzer on an IBM WebSphere 
4.0.5 application server.

● IBM WebSphere 5 – Installs Hyperion Analyzer on an IBM WebSphere 
5 application server.

● WebLogic 6.1 – Installs Hyperion Analyzer on a BEA WebLogic 6.1 
application server.
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● WebLogic 7.0 – Installs Hyperion Analyzer on a BEA WebLogic 7.0 
application server.

Note: The HP-UX operating system only supports the Apache Tomcat 4.0 and 4.1 
application server options.

10. Select Next.

The Application Server Information window is displayed. 

Figure 12:  Application Server Information (Tomcat)
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11. Based on the application server option you selected, provide the following 
settings:

Table 3: Application Server Information Settings 

Application Server Settings

Apache Tomcat 4.1.18 1. From Web Server list, select Use Default or 
Microsoft Internet Information Services (IIS)

2. Enter the Servlet Engine Name, Analyzer7_Server 
is the default.

3. Enter the HTTP Port Address, 80 is the default.

4. Enter the Host Alias, the machine name of the server 
running the installer is the default.

Apache Tomcat 4.1 or 
4.0 (preinstalled)

1. From Web Server list, select Use Default or 
Microsoft Internet Information Services (IIS)

2. Enter the Servlet Engine Name, Analyzer7_Server 
is the default.

3. Enter a path to the Application Server Home, or 
click the ellipses (...) button to browse to the root 
directory.

4. Enter the Port; 80 is the default.

5. Enter the Host Alias, the machine name of the server 
running the installer is the default.
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12. Click Next.

IBM WebSphere 4.x or 
5.x (preinstalled)

1. Enter the Servlet Engine Name, Analyzer7_Server 
is the default.

2. Enter a path to the Application Server Home, or 
click the ellipses (...) button to browse to the root 
directory.

3. Enter the Port (HTTP Server); 80 is the default.

4. Optional: Click Advanced to set Fully qualified 
host name to a name that differs from the server 
name.

BEA WebLogic 6.1 or 
7.0 (preinstalled)

1. Enter the Servlet Engine Name, Analyzer7_Server 
is the default.

2. Enter a path to the Application Server Home, or 
click the ellipses (...) button to browse to the root 
directory.

3. Enter the Port (HTTP Server); 80 is the default.

4. Optional: Click Advanced to set Fully qualified 
host name to a name that differs from the server 
name.

Table 3: Application Server Information Settings (Continued)

Application Server Settings
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The Select RDBMS Repository Type window is displayed, as shown in 
Figure 13. Specify the relational database for your Hyperion Analyzer 
repository here. 

Figure 13: Select RDBMS Repository Type 

13. Select the RDBMS Repository Type.

14. Click Next.

Table 4: Options for the Supported RDBMS

RDBMS Options

IBM DB2 Enterprise 
Sever Edition

Create Tables - creates only the repository in an 
existing database and RDBMS installation.

Oracle • Create Tables - creates only the repository in an 
existing database and RDBMS installation.

• Create Database - creates both the tablespace and 
repository in an existing RDBMS installation.

Note: Root user permissions are required to create a 
tablespace in Oracle.
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The Configure RDBMS Repository window is displayed. 

15. Enter the following RDBMS specific connection information into the 
Configure RDBMS Repository window according to the following tables.

16. Click Next.

Table 5: DB2 Enterprise Edition Connection Information

Text Box Entry

Server Name The explicit database server name. Using 
“localhost” is not recommended

Database Name The database application name. The default is 
ANALYZ70.

JDBC Driver Location The path to the JDBC driver; the default filename is 
db2java.zip.

Port The port number used for client-server communication; 
the default is 50000.

Table 6: Oracle Connection Information

Text Box Entry

Server Name The explicit database server name. Using 
“localhost” is not recommended.

SID The Oracle SID.

Database Name The name of the Oracle tablespace.

JDBC Driver Location The path of the Oracle JDBC driver; the default 
filename is classes12.zip.

Port The port used for client-server communication.
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The Repository User Information Window is displayed, as shown in 
Figure 14. You must enter a DBA user name, which the installation uses to 
create and modify the repository. In addition, you must provide an Analyzer 
user name, which the Hyperion Analyzer Server uses to communicate to the 
Hyperion Analyzer repository.

Figure 14: Repository User Information 

17. Enter the DBA and Analyzer user information and click Next.

Tip: You can click Test Connection to verify that there are no connectivity issues with 
the repository. If the connection to the repository is successful, you can continue with 
the installation. If the repository connection fails, you should verify your DBA user name 
and password and troubleshoot the problem within your database software. 

At this point in the installation process you can specify the JDBC drivers for 
an RDBMS type to establish a drill-through connection with another, existing 
database. This second set of RDBMS type and JDBC driver selections that 
supports relational drill-through and relational connections (Virtual Cubes) 
functionality is optional.

18. Perform one of the following tasks:

● If a drill-through or relational (Virtual Cubes) connections are not 
required, proceed to step 20.
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● If a drill-through or relational (Virtual Cubes) connections are required, 
select an available RDBMS type:

– DB2 Enterprise

– MS SQL Server 

– Oracle

– Teradata

A corresponding JDBC driver path field is displayed. 

19. Enter or browse to the path name of the JDBC driver. For example, the JDBC 
driver file name for Oracle is classes12.zip. 

20. Click Next.

The Installation Summary window is displayed. The summary provides a list 
of your configuration selections.

Note: Please be patient, it may take slightly longer for the Summary window to appear.

21. Review the summary and perform one of the following tasks:

● To make corrections in the installation configuration, click Back.

● If the configuration is correct, click Next.
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Hyperion Analyzer is installed. When the installation is complete, the Setup 
Complete window is displayed.

Figure 15:  Installation Complete

Note: The default user and password are Administrator and password respectively. You 
can use the installation log file to troubleshoot installation problems. You can find the log 
file in <Hyperion Home>/Analyzer_Install.log. The Hyperion Home 
directory is the directory you specified on the second window of the Hyperion Analyzer 
installation.

22. Click Finish.

The Setup Complete window closes and the installation of Hyperion Analyzer 
for UNIX is complete.

23. Log off and log back on to the server.

CAUTION: You must log off of the server and log on again after sourcing 
the analyzer.sh into the profile for Hyperion Analyzer to operate properly.
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After Installing Hyperion Analyzer
Before launching Hyperion Analyzer, you must perform the steps described in the 
following topics, as applicable to your installation choices:

● “Configuring IBM DB2 JDBC 2.0 Drivers” on page 48

● “Manual Deployment of WebSphere and WebLogic” on page 48

● “Configuring External and Application Security” on page 49

● “Setting Environmental Variables” on page 49

● “Starting the Hyperion Essbase OLAP Server” on page 52

● “Starting RDBMS Services” on page 52

● “Starting the Hyperion Analyzer Server” on page 52

Configuring IBM DB2 JDBC 2.0 Drivers

➤ To configure the DB2 RDBMS to use JDBC 2.0 drivers:

1. Stop all database services.

2. Run usejdbc2.bat in the sqllib\java12 subdirectory.

Note: When configuring the JDBC drivers for IBM DB2 8.1, ensure that the 
db2jcc.jar file is in the same directory as the db2java.zip file.

3. Restart all database services.

Note: When installing the Hyperion Analyzer repository into an existing DB2 
database, you must provide a user name and the database information to complete 
the installation. The user name you provide must be assigned to the database.

Manual Deployment of WebSphere and WebLogic
If you selected an existing installation of IBM WebSphere or BEA WebLogic as 
the application server to deploy Hyperion Analyzer into, you must execute some 
manual deployment configurations before continuing. The following chapters 
provide the procedures and information required to deploy manually to the 
application servers:

● Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere”

● Chapter 5, “Deploying Hyperion Analyzer into BEA WebLogic”
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Configuring External and Application Security
After you install Hyperion Analyzer you have the option of implementing one of 
several security methods. Security can be broken down into external authentication 
and internal authorization. Hyperion Analyzer provides the following options for 
implementing security:

● Analyzer Security (default)

● Essbase Security

● External Authentication

The default Hyperion Analyzer security configuration is application security. 
Without a valid user name and password, which is contained in the Hyperion 
Analyzer repository, you are not authenticated as a user in Hyperion Analyzer.

Although not required for Hyperion Analyzer to operate, it is advisable to 
implement an external authentication method for integrating with other Hyperion 
products. This is provided by utilizing existing Hyperion Essbase security or 
configuring an existing authentication method such as the following:

● Lightweight Directory Access Protocol (LDAP)

● Microsoft Windows NT LAN Manager (NTLM)

● Microsoft Active Directory (MSAD)

For more information on these security options see Chapter 2 “Managing Security 
and Access” of the Hyperion Analyzer Administrator’s Guide.

Setting Environmental Variables

➤ To set the environment variables:

1. Ensure that Essbase or an applicable runtime client is installed and configured, 
and that two (2) environmental variables are set correctly.

● ARBORPATH

● Set the variable to one of the following:

– LD_LIBRARY_PATH for Sun Solaris

– LIBPATH for IBM AIX

– SH_LIB_PATH for HP_UX
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If Hyperion Essbase is installed, the Library path should be correctly defined. See 
the examples below for detailed descriptions.

The Hyperion Analyzer installation generates an analyzer.sh script and stores 
it in the user home directory. This script enables client-server communication 
between Hyperion Analyzer and Hyperion Essbase, and indicates the language to 
be used by the Hyperion Analyzer interface.

2. Edit the global shell environment to reference the Hyperion Analyzer shell 
script located in the user home directory. For example:
. /.analyzer.sh

3. Log off and then log on again to ensure that the environment detects the 
changes.

The following sections provide environmental variable examples for each of the 
supported UNIX operating systems.

IBM AIX 4.3.3 Example

.profile entries:
export ARBORPATH=/usr/hyperion/essbase
export PATH=$ARBORPATH/bin:$PATH

#LIBPATH
export LIBPATH=
$ARBORPATH/dynamic:$ARBORPATH/api/lib:$ARBORPATH/bin

. /.analyzer.sh

.analyzer.sh entries:
LIBPATH=/usr/Hyperion/common/adm/7.0.0/bin/aix:$LIBPATH
#
#
export LIBPATH
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Sun Solaris 8 Example

.profile entries:
ARBORPATH=/opt/hyperion/essbase
export ARBORPATH
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/hyperion/essbase/bin
export LD_LIBRARY_PATH

. /.analyzer.sh

.analyzer.sh entries:
LD_LIBRARY_PATH=
/opt/Hyperion/common/adm/7.0.0/bin/solaris:$LD_LIBRARY_PATH
#
#
export LD_LIBRARY_PATH

HP-UX 11i Example

.profile entries:
export ARBORPATH=/usr/hyperion/essbase65r
export SHLIB_PATH=$ARBORPATH/bin

.analyzer.sh entries:
SHLIB_PATH=/usr/Hyperion/common/adm/7.0.0/bin/hpux:$SHLIB_PATH
#
#
export SH_LIB_PATH
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Starting the Hyperion Essbase OLAP Server

➤ To start the Essbase OLAP server:

1. Navigate to the $ARBORPATH/bin directory and type Essbase.

2. Enter a valid password and press Enter.

Starting RDBMS Services
The following section describes how to start RDBMS services for IBM DB2.

Starting the Hyperion Analyzer Server
Follow the instructions in your application server documentation to start 
application servers other than Apache Tomcat. If you selected Apache Tomcat as 
your application server, the next section provides procedures to start and stop the 
server.

Starting and Stopping the Tomcat Application Server
If you selected the Apache Tomcat application server during the installation 
process, you must start the server before launching Hyperion Analyzer and stop 
the server when your work is complete.

➤ To start the Apache Tomcat application server, change the directory to the Tomcat 
root directory and change the directory to /bin/. Then, run the 
analyzer_startup.sh script. If you installed Tomcat during the Hyperion 
Analyzer installation, the default path is: 
$HYPERION_HOME/common/appServers/Tomcat/4.1.18/bin 

➤ To stop the Apache Tomcat application server, change the directory to the Tomcat 
root directory and change the directory to /bin/. Then, run the 
analyzer_stop.sh script.

Starting Hyperion Analyzer
Deploy the following Hyperion Analyzer launch page URL to your users:

http://<hostname>/Analyzer7_Server/index.html
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➤ To start the Hyperion Analyzer Client:

1. Open a browser, enter the launch page URL, and press Enter.

The Hyperion Analyzer Launch Page is displayed.

Figure 16: Hyperion Analyzer Launch Page
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2. Select from the following list of options:

● Java Web Client

● HTML Web Client

● Administration Tools Client

● Analysis Server Console

The selected option opens in a new browser window. The appropriate client 
starts and the Login page is displayed.

Note: If you do not have the correct Java console, you are prompted to permit it to 
be automatically installed.

3. Enter a valid User ID and Password, then click Login.

The Hyperion Analyzer Launch Page

The Hyperion Analyzer Launch Page is a great source of information and other 
Hyperion Analyzer resources. From the Launch Page you can:

● Link to Essbase.com

● Launch the Information Map

● View instructions on how to install a sample report group

● Access to the Hyperion Analyzer API Toolkit Jump Start Guide

● Launch a sample HTML Web Client
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This chapter provides information on what is installed with Hyperion Analyzer 
and where it is located. Installation locations are based on the deployed application 
server. Typically, a Hyperion Analyzer installation is structured as described in the 
tables in the following sections.

Hyperion Analyzer Top-Level Directories
The following directories are installed inside your Hyperion Home directory, by 
default this is Hyperion/. For example, /opt/Hyperion/.

Note: If you installed Hyperion Analyzer to a different location, other than the Home 
directory, the /Analyzer/ directory appears in the location you specified. For example, 
your Hyperion Home directory might be //Hyperion/ and your Hyperion Analyzer 
installation directory might have a different path, such as //HyperionApps/.

Table 7: Hyperion Analyzer Top-Level Directories

Directory Description

Analyzer The directory containing configuration files, generated 
ear files and Analyzer 5 Migration Utilities.

common The directory containing the common Hyperion 
components such as ADM, application servers, 
Common Security Services (CSS), Hyperion Pluggable 
Look and Feel, JDK, and loggers.
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Hyperion Analyzer Directories
If you installed Hyperion Analyzer on an existing Application server the 
directories are in the following directory path:
/Hyperion/Analyzer/

All of the Hyperion Analyzer files are contained in the Analyzer.ear file. See 
Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” or Chapter 5, 
“Deploying Hyperion Analyzer into BEA WebLogic,” for more information about 
deploying the EAR file. The Analyzer directory contains an \Ear subdirectory. 
This contains the contents of the EAR file. When changes are made to the 
deployment, they can be made to this directory. Then when it is time to redeploy 
the EAR file, you can rebuild it using the 
/analyzer/7.0.0/utils/rebuild_ear.sh file.

Table 8: Hyperion Analyzer Server Directories

Directory Description

conf Contains configuration files.

cssdepends Contains the necessary files for common security and 
guided analysis.

docs Contains Hyperion Analyzer documentation.

ear The directory containing exploded ear structure for the 
Analyzer Web Application.

sql Contains the SQL scripts for building the Analyzer 
repository.

tomcat Contains the configured web.xml to be used by 
Tomcat.

utils Contains the migration utilities for previous versions 
of Hyperion Analyzer and for rebuilding the Analyzer 
ear file.

weblogic6 Contains files necessary to rebuild the Analyzer ear file 
for BEA WebLogic 6 deployments.

weblogic7 Contains files necessary to rebuild the Analyzer ear file 
for BEA WebLogic 7 deployments.
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websphere4 Contains files necessary to rebuild the Analyzer ear file 
for IBM Websphere 4 deployments.

websphere5 Contains files necessary to rebuild the Analyzer ear file 
for IBM Websphere deployments.

Table 8: Hyperion Analyzer Server Directories(Continued)

Directory Description
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Hyperion Common Directories
Table 9 describes the directories installed in the Hyperion Home directory.

Table 9: Hyperion Common Directories

Note: If you installed Apache Tomcat with Hyperion Analyzer, the server directories are 
in the following Hyperion Home directory path:
/hyperion/common/appservers/Tomcat/4.1.18/webapps/Analyzer7_
Server/. If you installed Hyperion Analyzer with an existing Apache Tomcat 
installation, the server directories are in the following directory path:
<tomcatinstallroot>/appserver/webapps/Analyzer7_Server/

Directory Description

adm Contains the Hyperion Analytical Data Model 
highest directory level (a Java API to Hyperion 
Essbase).

appServers Contains the application server installed with 
Hyperion Analyzer, such as Tomcat. In addition, the 
Analyzer7_Server directory is stored within the 
application server directory. It includes the Analyzer 
Launch page and utilities such as 
ClassFactoryConfig.bat.

CSS Contains JRE jar files for implementing external 
authentication.

HyperionHub Contains the Hyperion Hub client.

HyperionLookAndFeel Contains the common Hyperion Pluggable Look and 
Feel jar file.

JDK Contains the Java SDK files.

loggers Contains the Log4j files.
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If you are using IBM WebSphere 4, you must manually deploy Hyperion Analyzer 
into a previously installed IBM WebSphere application server. It is assumed that 
you have met all system requirements and that you executed the Hyperion 
Analyzer installation, including the selection of IBM WebSphere as the 
application server.

Deploying to IBM WebSphere

Deploying to IBM WebSphere Advanced Edition
The following procedures apply to IBM WebSphere 4 Advanced Edition. If you 
are using IBM WebSphere 4 Advanced Edition Single Server, proceed to 
“Deploying to Advanced Edition Single Server” on page 62.

Installing the Web Application

➤ To install the Hyperion Analyzer Web application:

1. Copy the Analyzer70.ear enterprise archive file from the /Analyzer/ 
directory to the WebSphere /Installable Apps/ directory.

CAUTION: Do not place the archive file in the InstalledApps directory 
or Hyperion Analyzer is unable to start.

2. Open the WebSphere Administration Server Console.
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3. Right-click the Enterprise Applications node in the navigation window (on 
the left side of the console interface).

4. Select Install Enterprise Application.

Note: Leave the Application Name field blank on this window.

5. Click Browse, navigate to the Analyzer70.ear enterprise archive file 
located in the Installable Apps directory, and open it.

6. Click Next.

Setting Up WebSphere Security
During the deployment process, you are prompted to set up WebSphere system 
security by the Mapping Users to Roles dialog box.

➤ To set up WebSphere security and define user permissions:

1. Select Everyone, click the Mapping Users to Roles select button.

2. In the Select Users/Groups – Everyone dialog box, select the Everyone (No 
authentication) check box, then click OK.

WebSphere indicates that all Hyperion Analyzer users belong to a single 
security group, called Everyone. You can specify Hyperion Analyzer roles 
and permissions later, using Hyperion Analyzer Administration Tools.

3. Proceed through the next series of installation pages until you reach the 
Selecting Application Servers page. 

This window enables IBM WebSphere Enterprise Server Edition to specify 
the application servers in the network cluster supporting Hyperion Analyzer.

Confirm the Following is the last page in the series. 

4. Ensure that the node, port, and the fully qualified path name to the 
InstalledApps directory appear in the Confirm the Following page. 

These descriptions must be correct and match the information you provided 
during the Hyperion Analyzer installation exactly. If they do not, you have the 
option of reinstalling or modifying the web.xml configuration file manually.

5. Click Finish to complete installation of the enterprise application.
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Regenerating the Web Server Plug-in

➤ To regenerate the Web Server Plug-in:

1. Open the WebSphere 4 Administration Server Console.

2. Expand Nodes in the navigation window (at the left side of the console 
interface).

3. Right-click the server node where Hyperion Analyzer is installed.

4. Select Regen Webserver Plug-in.

5. Go to Microsoft Windows Services and stop and start the IBM HTTP Server.

6. Reboot the WebSphere server for the new environmental variables to take 
effect.

Start the Hyperion Analyzer Web Application
Before you start the Hyperion Analyzer Web Application, make sure you set the 
environmental variables, as described in “Setting Environmental Variables” on 
page 49.

➤ To start the Hyperion Analyzer Web application:

1. Open the WebSphere Administration Server Console.

2. Expand the Enterprise Application node in the navigation window (on the 
left side of the console interface).

3. Right-click the Hyperion Analyzer application.

4. Select Start.

5. Open a Web browser and enter the URL provided in the last window of the 
Hyperion Analyzer installation. The default URL is
http://<server-name>/Analyzer7_Server/index.html.

The Hyperion Analyzer launch page is displayed, and you can begin 
multidimensional and relational analysis with the Hyperion Analyzer client of 
your choice.
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Deploying to Advanced Edition Single Server
The following sections describe how to deploy Hyperion Analyzer to Advanced 
Edition single server.

Installing the Web Application

➤ To install the Hyperion Analyzer enterprise application:

1. Copy the output Analyzer70.ear enterprise archive file from the 
/analyzer/ directory to the WebSphere Installable Apps directory.

CAUTION: Do not place the archive file in the InstalledApps directory 
or Hyperion Analyzer will not start.

2. Open the WebSphere Administration Server Console.

3. Expand the Nodes node and the server node where you want to install 
Hyperion Analyzer, then select Enterprise Application.

4. Click the Install button.

Note: Leave the Application Name field blank on this window.

5. Use the Browse button to navigate to the enterprise archive file in the 
Installable Apps directory.

6. Click Next.

Set Up WebSphere Security
During the deployment process you are prompted to set up WebSphere system 
security. The WebSphere Application Installation Mapping Roles to Users page 
indicates that all Hyperion Analyzer users belong to a single security group, called 
Everyone.
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➤ To set up WebSphere security and define user permissions:

1. On the Mapping Roles to Users page, select the Special Subjects Everyone 
check box.

You can specify Hyperion Analyzer roles and permissions later, using 
Hyperion Analyzer Administration Tools.

Confirm the Following is the last page in the series. 

2. Ensure that the node, port, and the fully-qualified path name to the 
InstalledApps directory appear on the Confirm the Following page.

These descriptions must be correct and match the information that you 
provided to the Hyperion Analyzer installation exactly. If they do not, you 
have the option of reinstalling or modifying the web.xml configuration file 
manually.

3. Click Finish to complete installation of the enterprise application.

Regenerating the Web Server Plug-in
If you have installed the Web Server as a service, you should regenerate the Web 
Server plug-in.

➤ To regenerate the Web Server Plug-in:

1. Open the WebSphere 4 Administration Server Console.

2. Expand the Nodes node and the server node where Hyperion Analyzer is 
installed. Expand the Application Servers node, then click Default Server.

3. Under the Advanced Settings banner, click Web Server Plug-in 
Configuration.

4. Click Generate.

5. Go to Microsoft Windows Services and stop and start the IBM HTTP Server.
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6. Reboot the WebSphere server for the new environmental variables to take 
effect.

Starting the Hyperion Analyzer Web Application
Before you start the Hyperion Analyzer Web Application, make sure you set the 
environmental variables, as described in “Setting Environmental Variables” on 
page 49.

➤ To start the Hyperion Analyzer Web application:

1. Open the WebSphere Administration Server Console.

2. Locate and expand the Nodes node and the node where Hyperion Analyzer is 
installed. 

3. On the left side of the console interface, click the Enterprise Application 
node in the navigation page.

4. Select the new Web application item check box (Analyzer70).

5. Click Start.

6. To continue the installation process, see Chapter 2 – Configuring External and 
Application Security.   
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Deploying to BEA WebLogic 
You must manually deploy Hyperion Analyzer to a previously installed BEA 
WebLogic 7.0 application server.

➤ To manually deploy Hyperion Analyzer to a BEA WebLogic 7.0 application 
server:

1. Start the BEA WebLogic Server.

2. Start the WebLogic Server Console.

3. Navigate to Deployments > Applications, then click Configure a new 
Application.

4. Click the correct drive and navigate to the newly created enterprise archive 
(EAR) file.

5. When the correct EAR file is displayed, click its corresponding [select] 
hyperlink.

6. Step 3 of the deployment process prompts you to indicate the server to which 
the EAR file is deployed.

7. Select an Available Server, and move it to the Target Server window using 
the arrow button control.

8. Enter a name for the Application in the Step 4 field, the default is 
“Analyzer70”.

9. Click the Configure and Display control button.

10. The WebLogic Server EAR file is configured and deployed.

11. To continue with the installation, return to “Configuring External and 
Application Security” on page 49.
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Database administrators might want to create repositories by running scripts rather 
than distributing their security information. You can find all SQL scripts in the 
/Analyzer/sql directory.

You can run the scripts for each of the RDBMS types that Hyperion Analyzer 
supports. The following sections contain the procedures for creating repositories:

“Creating the Repository for IBM DB2” on page 67

“Creating the Repository for Oracle” on page 69

“Creating the Repository for SQL Server” on page 71

Creating the Repository for IBM DB2
There are three scripts for creating an IBM DB2 repository:

● AnalyzerCreateDatabaseDB2.sql creates a DB2 database.

● AnalyzerCreateTablesDB2.sql creates all repository tables for both 
editions of DB2.

● AnalyzerDefaultDataDB2.sql populates tables with Hyperion Analyzer 
default configuration data in the database that was created using the SQL 
script.
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➤ To create an IBM DB2 repository:

1. Open the AnalyzerCreateDatabaseDB2.sql script in an SQL editor and 
modify the following parameters.

2. Save your modifications and run the SQL script.

3. Open the AnalyzerCreateTablesDB2.sql script in an SQL editor and 
modify the following parameters.

Table 10: AnalyzerCreateDatabaseDB2.sql Script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. 
Replace with ANALYZ70.

****DBNAME**** The Hyperion Analyzer database name. 
Replace with ANALYZ70.

****DB2USERNAME**** Replace with the user ID of the DB2 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding DB2 
Administrator's password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

Table 11: AnalyzerCreateTablesDB2.sql Script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ70.

****DBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ70.

****DB2USERNAME**** The user ID of the DB2 administrator. 
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Creating the Repository for Oracle

6

4. Save your modifications and run the SQL script.

5. Open the AnalyzerCreateDatabaseDB2.sql script in an SQL editor and 
modify the following parameters.

6. Save your modifications and run the SQL script.

Creating the Repository for Oracle
There are four scripts for creating a Oracle repository:

● AnalyzerCreateDatabaseOracle8i.sql creates the Oracle database.

● AnalyzerCreateTablesOracle8i.sql creates the Hyperion Analyzer 
repository tables.

● AnalyzerDefaultDataOracle8i.sql populates the tables with Hyperion 
Analyzer default configuration data.

****DB2PASSWORD**** Replace with the corresponding DB2 
Administrator's password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

Table 12: AnalyzerCreateDatabaseDB2.sql script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ70.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Table 11: AnalyzerCreateTablesDB2.sql Script Parameters for IBM 

Parameter Description
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● AnalyzerCreateRemoveOracle8i.sql is a script used internally by the 
create database script.

➤ To create an Oracle repository:

1. Open the AnalyzerCreateDatabaseOracle8i.sql script in a SQL editor 
and modify the following script parameters.

2. Run the AnalyzerCreateDatabaseOracle8i.sql script.

3. Open the AnalyzerCreateTablesOracle8i.sql script in a SQL editor 
and modify the following script parameters.

4. Run the AnalyzerCreateTablesOracle8i.sql script.

Table 13: AnalyzerCreateDatabaseOracle8i.sql script Parameters for Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding Administrator's 
password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

****PASSWORD**** Replace with the corresponding CAPSUSER 
password.

Table 14: AnalyzerCreateTablesOracle8i.sql Script Parameters for Oracle

Parameter Description

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight 
(8) characters.
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5. Open the AnalyzerDefaultDataOracle8i.sql script in a SQL editor and 
modify the following script parameters:

6. Run the AnalyzerDefaultDataOracle8i.sql script.

Creating the Repository for SQL Server
There are four scripts for creating a SQL Server repository:

● AnalyzerCreateDatabaseMSSQL.sql creates the SQL Server database.

● AnalyzerCreateTablesMSSQL.sql creates the Hyperion Analyzer 
repository tables.

● AnalyzerDefaultDataMSSQL.sql populates the tables with Hyperion 
Analyzer default configuration data.

● AnalyzerRemoveDatabasesMSSQL.sql is a script used internally by the 
create database script.

Table 15: AnalyzerDefaultDataOracle8i.sql Script Parameters for Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding Administrator's 
password.

****USERNAME**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.
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➤ To create an SQL Server repository:

1. Open the AnalyzerCreateDatabase.sql script in a SQL editor and 
modify the following script parameters:

2. Run the AnalyzerCreateDatabaseMSSQL.sql script.

3. Open the AnalyzerCreateTablesMSSQL.sql script in a SQL editor and 
modify the following script parameters:

4. Select the correct database from the query analyzer tool drop-down list box.

5. Run the AnalyzerCreateTablesMSSQL.sql script.

6. Run the AnalyzerDefaultDataMSSQL.sql script.

Table 16: AnalyzerCreateDatabase.sql Script Parameters for SQL Server

Parameter Description

****DBNAME**** The Hyperion Analyzer database name. Replace with 
ANALYZ70.

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight 
(8) characters.

****PASSWORD**** Replace with the corresponding USERNAME 
password.

Table 17: AnalyzerCreateTablesMSSQL.sql Script Parameters for SQL Server

Parameter Replace With

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight (8) 
characters.
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Importing Hyperion Analyzer 
Sample Reports
Hyperion Analyzer provides sample reports contained in two report groups for you 
to import into your Hyperion Analyzer repository based on the Hyperion Essbase 
sample application:cube called Sample:Basic. The following topics describe how 
to import the Sample Reports and the API Samples report groups:

● “Creating a Database Connection” on page 74

● “Importing the Sample Report Group” on page 75

● “Importing the API Samples Report Group” on page 76

The procedures in this chapter assume the following conditions:

● Hyperion Analyzer is installed.

● A valid Essbase OLAP server has been started.

● A valid application server has been started.
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Importing Sample Reports
The following sections describe how to create a database connection and import 
the sample reports.

Creating a Database Connection
It is necessary to create a database connection to the Hyperion Essbase cube before 
importing the sample reports.

➤ To import the sample report group and reports:

1. Start a supported Web browser.

2. Select File > Open.

3. Enter the URL of the Hyperion Analyzer launch page, and press Enter.

For example:

http://<servername>/Analyzer7_Server/index.html

4. On the Hyperion Analyzer Launch Page, click the Java Web Client link.

Hyperion Analyzer starts, and the Login dialog box is displayed.

5. Enter a valid user ID and password (Administrator/password) and click OK.

6. In Hyperion Analyzer, select Tools > User Preferences from the drop-down 
menu.

The User Preferences dialog box is displayed.

7. Click Connections.

The available connections display.

8. Click the Add New button.

The Select Database Type dialog box is displayed.

9. Select Essbase from the drop-down list and click OK.

The Hyperion Essbase Login dialog box is displayed.

10. Specify the Hyperion Essbase server, and a valid Hyperion Essbase user ID 
and password, then click OK.

The List Databases dialog box is displayed.
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Importing Sample Reports

7

11. Select Sample:Basic from the Available Databases list and click the 
right-arrow (>) button.

Sample:Basic is added to the Selected Databases list.

12. Click OK.

Sample:Basic is added to the Connections User Preferences list.

13. Click Apply, then click Close.

Importing the Sample Report Group
It is necessary to import a report group by using the Java Web Client.

Note: You must be an Administrator or Power User and have write privileges to import 
a report group.

➤ To import a sample report group:

1. From the Java Web Client Menu Bar select File > Import > Report Group.

The Open dialog box is displayed.

2. Select the Sample Reports.ARG file located in the Hyperion Home 
directory. For example, if you are using Apache Tomcat the Hyperion Home 
directory is:

Hyperion/common/appServers/Tomcat/4.1.18/webapps/Analyzer7_
Server/samples

The Map Connections dialog box is displayed.

3. Select localhost:Sample:Basic from the Exported Connection list, then 
select the database connection that you just created in the Available Database 
Connections list.

4. Click the Map It! button.

5. Click OK.

6. Type Sample Reports for the report group name and click OK.

The report group is saved to the repository.
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Importing the API Samples Report Group

➤ To import the API Samples report group:

1. From the Java Web Client Menu Bar select File > Import > Report Group.

The Open dialog box is displayed.

2. Select the api_samples.ARG file located in the Hyperion Home directory. 
For example, if you are using Apache Tomcat the Hyperion Home directory 
is:

Hyperion/common/appServers/Tomcat/4.1.18/webapps/Analyzer7_
Server/samples

The Map Connections dialog box is displayed.

3. Select localhost:Sample:Basic from the Exported Connection list, and then 
select the database connection you just created from the Available Database 
Connections list.

4. Click the Map It! button.

5. Click OK.

6. Type API Samples for the report group name and click OK.

The API Samples report group is saved to the repository.
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8

Uninstalling Hyperion Analyzer from UNIX

➤ To uninstall Hyperion Analyzer from your UNIX system:

1. Login in to the server.

2. In the root folder where you installed Hyperion Analyzer, navigate to 
Hyperion/_uninstall/.

3. Execute uninstaller.bin.

4. After the uninstall is complete, you can manually delete the Hyperion 
Analyzer directory.

5. Perform one of the following:

● If you modified the analyzer.sh file to set the environment variables, 
edit out the environment variable changes you made.

● Remove the set resource environment variables. 

Hyperion Analyzer has been removed from your system.
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